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Chapter 1

About Device

The information contained in this document is provided “as is” and is 
subject to change without notice.



What’s in the Box? 

Device Cradle 

AC Adapter Ear-Phone 

User Manual & Quick Reference 

USB Cable 

Companion CD  

Battery (slim & standard) 

Remote Control  

Screen Cleaner Hand Strap Fancy Metal Hand Strap 



Hardware Features 

1. Phone state LED: It flashes when a phone-call comes in and displays the state of 

mobile phone. It notifies you of phone state including SMS. 

2. Internet Explorer Key( ) : allows you to open Internet Explorer.  

3. GPS Key( ) : allows you to open GPS program. 

4. Touch screen(TFT LCD): Tap on-screen controls or buttons to select menu 

commands or input text. 



5. Home Key( ) : allows you to open POZ Launcher. 

6. Rotate Key( ) : allows you to open POZ Rotate program. 

7. Send( ) button : allows you to make a call. Press it once to have the last called 

phone number displayed on the phone display with the phone program on. 

8. End( ) button : allows you to end a call. 

9. Wheel button : allows you to rotate and push down top/bottom/left/right. 

10. Action button : allows you to open the selected item. 

11. Receiver: allows you to hear the voice while talking over the phone. 

12. Phone keypad : allows you to input the phone number. 

13. Mode changing key( ) :allows you to change input mode(number, capital letter, 

and lower letter) of your keypad.  

14. Microphone: allows you to speak into the microphone to record voice notes and 

communicate on the mobile phone. 

15. Clear key( ) : allows you to delete the characters you input before. When you 

hold down the delete key, all characters you have input will be deleted. 

Home Key, Rotate Key, Send Key and End Key include Charging State LED. 

Charging state LEDs indicate power state while recharging.  

(Blue : fully charged, Red : currently charging)







1. USB port: Connect to your desktop PC using the supplied cradle, or directly 

through an optional sync cable.  







Using the Stylus 

Tap and hold the stylus on an item to see a list of actions available for that 

item. On the pop-up menu that appears, tap the action you want to 

perform.

Hold the stylus on the screen and drag across the screen to select text and 

images. Drag in a list to select multiple items.



 Soft Reset & Hard Reset



 Microsoft Pocket PC Software 

 ActiveSync. 

 Calendar. 

 Tasks. 

 Contacts. 

 Notes. 

 Inbox. 

 Pocket Word. 

 Pocket Excel. 

 Microsoft Pocket Internet Explorer. 

 MSN Messenger.1

 Microsoft Windows Media Player for Pocket PC.2

1 Requires an account with an Internet service provider. 
2 Check the Microsoft Mobile Devices Web site for updates to Windows Media Player, including details on 

support for video file formats and streaming audio and video capabilities.



 Where to Find Information 

ActiveSync & Acrobat Reader 

Using Help on Your Device 

Help Start

Using This Manual 



Chapter 2

Getting Started

The information contained in this document is provided “as is” and is 
subject to change without notice.



Powering up device 



Power Tips 

Red LED indicates that the battery is charging, and blue LED
indicates that the battery is fully charged. 

This LEDs indicates the state of main battery. 

This LED shows you the state of extra battery that may be seated on the 

back of this cradle. 



Connecting to your device 

Before you connect to your device, see if your desktop PC is on and 

Microsoft ActiveSync program is installed from companion CD. 

Port for USB cable 

Port for charging cable 



Windows 95 and Windows NT version don’t support beaming 

connection. 



Complete the Welcome wizard 

Gently touch the screen with stylus. From now on, 

it is called “tap”. 

A target (+) will move in the order of “center upper

left  lower left  lower right  upper right” on your 
screen. Since calibrating the touch screen has a 

direct affect on the recognition ability of your touch 

screen, be sure to accurately tap the center of the 
target (+) with your stylus. 



This is the way of how to single-tap and tap and 

hold, tap the Next button. 

Tap and hold this location to have next window. 



Tap and hold this location next to 11 to paste the 

cut contents. Then you will have the new pop-up 
menu.  

It is called “Pop-up” menu. Select Cut. 



Select Paste on this list. 

The pasted contents have appeared. Tap the Next 

button.



Select a time zone you stay from the drop-down 

list box. 

Tap the screen to finish the Welcome wizard. 



Using Today Screen 

Enter your personal information which is not 

synchronized with your desktop PC. 

Start menu 

Synchronize today with your desktop PC through 

ActiveSync. Command bar 

Navigation bar 



Now, you are ready to enter Owner information. Tap Owner information to have 

next screen. 

special characters 

Tap OK to save the current screen. 











Insert mini SD cards into the mini SD card slot so that Storage Card folder 

appears. Tap this folder to view the contents of mini SD card. 

Select to go to the higher level of 

a folder. 

Select a folder below My 

Device you want to move to. 



Select the new folder on the Edit menu of the Command bar. 

Enter the new folder name.  

Select “Delete” on the pop-up menu you tap and hold on this folder to delete 

this folder. 



Tap and hold the file you cut, copy, rename and delete to have Pop-up menu 

displayed. Also tap and hold files or folders to have a little different one from a 

pop-up menu that includes new folder.  

Now we show you an example of process where we copy a file from a folder 

and paste it to another folder.  

Tap and hold a file you copy to have Pop-up menu displayed and tap Copy. 

Select My Device you want to paste the copied file to. On the My Device folder, 

tap and hold the empty space to have pop-up menu that includes Paste. 

Select “Paste” on the text menu. 

Tap and hold a file you copy to have Pop-up 

menu displayed and tap Copy. 



Managing Memory 

Your device includes three kinds of memory:  

 160 MB of ROM,  

 64MB of storage and program memory (RAM),  

 optional SD memory cards. 

ROM(32MB OS + 128 MB File Store) 

This is a nonvolatile memory; that is, it will not be erased even if your device 

loses power. In other words, ROM is composed of 32MB memory and 128MB 

File Store.  

For more information on backing up your device to the File Store, see “Backing 

Up and Restoring Data” in chapter 4.  

Storage and Program Memory (64MB) 

The volatile RAM memory on your device is allocated between storage memory 

and program memory. The operating system automatically manages the 

allocation between storage and program memory; however, in some 

situations—such as when memory is low—it may not be able to adjust the 

memory properly. Bad sectors amongst the 64 Mb of RAM memory may cause 

shortages of memory. 

If you receive a message stating that storage or program memory is 

unavailable, try the following solutions. 

 To increase storage memory, you can 



To increase program memory, you can

Mini SD Memory Cards 

Mini SD memory cards are small, removable flash storage cards that enable 

you to expand the memory of your device. You can use mini SD memory cards 

for backup storage, archives, or to transfer large files to other devices. Mini SD 

cards can be purchased from a variety of third-party vendors.  
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- Using the Input Panel 

- Block Recognizer 

- Keyboard 

- Letter Recognizer 

- Transcriber 

Chapter 3

Using Input Panel

The information contained in this document is provided “as is” and is 
subject to change without notice.
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Using the Input Panel

Use the Input panel to enter information in any program on your device. 

You can write using keyboard, Block Recognizer, Letter Recognizer, or 

Transcriber. In any case, the characters appear as typed text on the 

screen.  

To show or hide the Input panel, tap the Input panel button. Tap the arrow 

next to the Input Panel button to see your choice.  



Chapter 3 Pocket PC Overview  3-3

Block Recognizer

Punctuation & symbol 

Space

English entry area Number entry area

Return 

Back space 

Input Panel for Block Recognizer 
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Keyboard

Back space 

Return

Space Input Panel for Keyboard Punctuation entry 
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Letter Recognizer

Back space 

Return

Space

Punctuation & symbol entry 

Number entry areaEnglish upper/lower case entry area 
Input Panel for Letter Recognizer 
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Transcriber

Tap here to select Transcriber 

backspace

Letter shapes 

Settings 

Display the current mode. 

Mini keyboard. 

Selected character 

Select one of 3 options according to how often you use 

the selected shape. 

Tap these arrows to see more choices. 
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Tap the punctuation & symbol entry button to have the next window 

displayed. 

With Transcriber you can write anywhere on the screen using the stylus 

just as you would on paper. Unlike Letter Recognizer and Block 

Recognizer, you can write a sentence or more of information; then, you 

pause and let Transcriber change the written characters to typed 

characters.
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Tap the Settings button to have the next window displayed. 

Select the width of pen and see 

sample displayed below 

Add space after entry 

Move the slide to right/left side to select speed 

and quality. 



Chapter 4 Connecting to Desktop PC  4-1

To get the most from your device, you will want to connect to your 

desktop or notebook PC. This chapter describes how to establish the 

connection between your device and your desktop PC, and how to 

synchronize and transfer files between your device and your desktop (or 

any PC that has Microsoft ActiveSync installed).  

Because Windows Mobile 2003 version is installed on your device, you 

have to install ActiveSync 3.8 version or later on your desktop PC instead 

of ActiveSync 3.6 or ActiveSync 3.5. 

- Install Microsoft ActiveSync and establish a partnership 

- Full Backup & Restore using Backup/Restore of ActiveSync 

- How to install programs using ActiveSync 

Chapter 4

Connecting to Desktop

The information contained in this document is provided “as is” and is 
subject to change without notice.
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You can download ActiveSync 3.8 or later from followings : 

ActiveSync 3.8 file is named as Setup.exe on companion CD, and 

ActiveSync 3.8 file is named as MSASYNC.EXE when it is downloaded 

from web site. 

To use your device, cradle your device and connect USB cable and the 

power cable with your desktop computer physically. Insert the Companion 

CD into CD-ROM drive of your desktop computer.  

From your initial screen of Companion CD, click the Start button > Install 

Microsoft ActiveSync 3.8. 

To get the most from your device, you have to connect to your desktop or 

notebook PC. Microsoft ActiveSync enables you to synchronize the 

information on your desktop PC with the information on your device.  In 

addition, you can back up data from your device to your desktop PC and 

On desktop computer, if Autorun doesn’t work, Microsoft 
ActiveSync setup can be launched by suing the run command. 
Click on Start, and then Run. In the text dialog box, enter the path 

for the setup file. Typically, you would type X: Setup.exe, where 

X is the letter for your CD-ROM drive. 
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restore this data to your device, and copy files between your device and 

desktop PC. Before you begin synchronization, install ActiveSync on your 

desktop PC from the provided Companion CD. ActiveSync is already 

installed on your device. 

After installation is complete, the ActiveSync Setup Wizard helps you 

connect your device to your desktop PC, establish a partnership so you 

can synchronize information between your device and your desktop 

computer, and customize your synchronization settings.  

This is an explanation on how to install ActiveSync 3.8, based on 

Windows 2000 Professional, so you may have a little bit different screen 

on the different OS versions from below. 

Select Run this program from its current location to install without saving. 
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Click Yes to move to the next screen. 

Click Next. 

Click Next. 

When the process becomes 100%, automatically it will go to the next 

screen.
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Connect USB port to desktop PC and the power cable to cradle. Then 

seat your device into USB cradle. 

A wizard of finding a new hardware will begin automatically as below. 

Click Next. 

Click Next. 
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Select CD-ROM drive and click Next. 

Click Next. 
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Click Finish and automatically the synchronization process will begin. And 

then the following processes will appear on your desktop PC. 

Instead of synchronizing, you may set up your device as guest. Even 

though a guest, you may transfer files and data between your device and 

your desktop PC. 

When you perform hard reset or re-establish a new partnership after 

deleting the existing partnership, you can select one of the options. 

A desktop PC can establish partnerships with several devices while one 

device can establish partnerships with up to two desktop PCs. However, 

you cannot synchronize two devices with one desktop PC at the same 

time.

Click Next. 

Now you are ready to synchronise 
between your device and the desktop PC.  

It may take a while for synchronisation to 

finish.  When set up as a Guest, you can 
find files by pressing the Explore button 

on the Toolbar. 
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Click Next. 

Click Finish. Now, you are ready to establish a new partnership.  

You will have the Microsoft ActiveSync screen as shown below. 

When you perform hard reset on your device, you need to change the 

This is the partnership name that is 
established with your desktop PC through 

ActiveSync.

These are the items you have selected for 

synchronizing with desktop PC. 

Select any items you want to synchronize 

and otherwise, deselect the others. 



Chapter 4 Connecting to Desktop PC  4-9

partnership name that is preset as Pocket_PC. (for example : 

Pocket_PC1, Pocket_PC2, Pocket_PC3, Pocket_PC4) 

When you have some difficulties synchronizing your device with your 

desktop PC, click the Connection Settings on the File menu to have the 

Connection Settings screen displayed as below. 
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Synchronization compares the data on your device with your desktop PC 

and updates both computers with the most recent information. For 

example, you can synchronize Microsoft Word and Microsoft Excel files 

between your device and desktop PC. Your files are automatically 

converted to the correct format. And you can synchronize e-mail 

messages in Inbox on your device with e-mail messages in Microsoft 

Outlook on your desktop PC. And you can keep your Pocket Outlook 

Contacts, Calendar, and Tasks databases up-to-dated by synchronizing 

your device with Microsoft Outlook data on your desktop PC. Use the 

ActiveSync options to select which information should be synchronized 

and to control how much data is synchronized. By default, ActiveSync 

does not automatically synchronize all types of information.  

Select Calendar and click the Settings button. 

Tap Settings to customize 
the selected item.  

Select any option you want to 
customize Pocket Calendar 
during the synchronizations.  
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Select Contacts and click the Settings button. 

Select Tasks and click the Settings button. 

Select any option you want 
to customize Pocket

Select any option you want 
to customize Pocket Tasks
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Select Favorites and click the Settings button. 

Select Inbox and click the Settings button. 

You have to select the 
folder you have made to 

In this example, while 
synchronizing, it is set as 
copy at most 100 lines to 
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Select Files and click the Settings button. 

After you customized ActiveSync and completed the first synchronization, 

you can control when synchronization occurs by selecting a 

synchronization mode. 

Select one of the 3 
options: continuously 

This is the folder that 
includes the file 
synchronized with your 
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Select the file(s) you want to copy and select Copy on the Edit menu or 

select Copy on the pop-up menu. For pasting file(s), select the Explore 

button on the Microsoft ActiveSync screen of your desktop PC to have the 

Mobile Device screen displayed as below : 

First, select the folder you want to paste and select Paste on the Edit 

menu or select Paste on the pop-up menu.  

However, when you transfer file(s) between desktop PC and your device, 

files created on your desktop PC may automatically need to be converted 

before you can use them on your device, and also files created on your 

device may automatically need to be converted before you can use them 

on your desktop PC. However, when you work with software such as 

ClearVue Presentations or ClearVue Image, files should not be converted 

to the different format. In other words, those software use the format 

identical to the corresponding software of your desktop PC. That’s why 

we need to change the settings of converting file format when files don’t

need to be converted before you can use them on your device.  

You can change the settings as follows :

Tap the Conversion 
Settings to change the 
options for conversion 
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Select Conversion Settings. 

Deselect this option box 
not to change the file 
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Full Backup & Restore using Backup/Restore of ActiveSync 

You can back up files, database, PIM data and programs installed in RAM 

to your desktop PC using Microsoft ActiveSync, and restore them when 

needed.

Backup can either be performed automatically when your device is 

connected to your desktop PC, or manually whenever needed. Also, you 

can back up updated or new data only or choose to back up all data. 

1. Connect your device to desktop PC. 

2. Tap Backup/Restore on the Tools menu of the ActiveSync screen. 

3. Select “Full backup” or “Incremental backup” according to your needs. 

4. You may need the backup file name and the folder when restoring your 

backup file. Tap the Change button to confirm the folder. 

5. Tap the Back Up Now button to begin. 

Tap Back Up Now to begin.  

Tap Change to 
change backup name.

Full backup 

Incremental backup. 

Automatic backup is only possible when a Partnership is 
established with a desktop PC. Only a manual backup is 
possible when the partnership is established as Guest. For 
more information on Backup/Restoring to and from a desktop 
PC, see Microsoft ActiveSync Help. 
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1. Connect your device to desktop PC. 

2. Close all programs running on your device. 

3. Establish a partnership as Guest. 

4. Tap Backup/Restore on the Tools menu of the ActiveSync screen, 

and select the Restore tab. 

Do not remove your device from the cradle or disconnect the 
USB cable during backup. 

As newly installed programs or new files created on your 
device since your last backup will be lost after restore, you 
should move them to your desktop PC or to File Store 
(NAND Flash memory) before you restore data.  

Select this options box 
to set up your device 
as guest. 
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5. Tap the Restore Now button. 

6. Select the backup file you want to restore and select OK to begin. 

7. Click Restore to begin the restore process. 

8. When completed, perform soft Reset on your device with your stylus 

and seat your device on your cradle to synchronize. 

Do not use your device until Restore is completed. 
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How to install programs using ActiveSync 

1. Download the program to your desktop computer (or insert the CD or 

disk that contains the program into your desktop computer). 

2. Connect your device to your desktop PC. 

3. If the program includes an installer program (typically named Setup.exe 

or Install.exe), double-click the installer program on the desktop PC. The 

installer program copies the necessary files to your device.  

1. Download the program to your desktop computer (or insert the CD or 

disk that contains the program into your desktop computer). 

2. Connect your device to your desktop PC. 

3. Use the ActiveSync Explore button to copy the cabinet (*.cab) file to the 

Program Files folder on your device, and then double-tap the icon on your 

device to install the program. 

4. Refer to the Read Me file or documentation that came with the program 

to be sure you have copied the necessary file(s). For more information on 

copying files using ActiveSync, see ActiveSync Help. 
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Chapter 5

Configuring Device
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Settings

1. the Personal tab 
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First, select a button among the 4 buttons 
and select a program you want for that 

button on the assignment. 

Move the slide to adjust the delay before 

first repeat. 

Move the slide to adjust the repeat rate. 
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It is recommended that you select the 

default mode of voice recording format to 

conserve your memory size. 

Select the default mode among Block 
Recognizer, keyboard, Letter Recognizer, 

Phone Dialer and Transcriber. 
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Selected items appear in the Start 

menu. Otherwise, the rest appear in 

Programs.

Select the Turn on New button menu 

item to have the selected items 

displayed on the New menu list. 



User’s Manual  5-6

Select this option box to show this 

information when device is turned on. 
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When you select the Strong alphanumeric 
password item, you have to enter the 7-digit 

password: a combination of the English upper 

case and lower case letters. 
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According to each event, select the 

corresponding sounds or 

notifications.
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2. the System tab 

While synchronized, this will be used 
for identifying itself and establishing 

a partnership.
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It is recommended to conserve your 

battery life that you turn off backlight 

if device is not used for the time you 
select here. 
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Select the right one according to where 
you stay. 
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To conserve the program memory, you can 

stop programs that are not being used. 
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Display the state of backup battery. 

While being seated on cradle, if main battery 

is not fully charged, it will move from 0 to 
100% on the charging bar 
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Select where you stay. 
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When the storage memory is 

short, remove the program 
installed on your device. 
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3. the Connections tab 
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Chapter 6

Using the Internet & Messaging
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 Browsing the Web on your device 

Using Microsoft Pocket Internet Explorer 

To start Pocket Internet Explorer 

1. On the menu, tap .

Mobile Favorites button 

Home button 

Refresh button
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Mobile Favorites folder 

To make Mobile Favorites 
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To make the Mobile Favorites button on the Tools menu of 

your desktop PC 
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To reduce the amount of memory caused by Mobile Favorites 
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To view Mobile Favorites offline 

Tap the favorite you want to view. 

Tap to add or delete a folder or favorite link. 
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 Sending and Receiving E-Mail Messages 

Synchronizing E-mail Messages 



User’s Manual  6-8

Select the folders you want to synchronize. 

Shows you this is a read mail message. 

Shows you this is a mail message with attachments 
that need to be downloaded. 
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Using the Message List

Select the sort order for messages. 

Tap to connect and to send and receive e-mail. 

Tap to connect to the 

selected service. 

Tap to return to the message list. 

Tap to delete this message. 

Tap to view the previous or next message. 

Tap to reply to or forward this message. 

When you select this message with attachments that 

is already downloaded, the message will open with 

attachments displayed on the bottom of screen. 




